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See the Installation and Activation Guide for instructions on 
installing and activating the software. 
 

If you are experiencing difficulties refer to the Troubleshooting section 
of that Guide. 
 

Launch the program 
 
The Installer has placed a shortcut icon on your desktop. 
 

 
You can also locate and open the program’s folder and launch from the programs’ .exe file 
 

 
 
Double click the program’s app file to launch. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Menus, Key shortcuts, and Buttons 

 
You can do things in the program by using drop down menus, key shortcuts and buttons. (See Appendix) 
 
The first dedicated ‘Program’ menu is the File Menu. 
 

 
 

Stand Alone or Plugin Modules 
 

 
 
Our software is released in two formats - Stand Alone and plugins. 
The Stand Alone versions operate independently of one another.  
 
That means there will be several distinct programs installed for people who want to keep their materials in 
separate collections. 
This is also good for managing the ‘footprint’ size of the database since each plugin will expand its size. 
 
The “Import New Plugins” command is used to update the database with new songs/charts. 
The basic requirement is that you are installing plugins into the RealBook Volume 1 software. 
None of the other stand alone programs allow for plugins. Each plugin has a second step for importing the 
media files. 
The plugins come with their own guide for Installation, so refer to those for specific instructions for the 
particular plugin you purchased. 
 

 
 
The remaining submenu “Updates” is used for audio updates that we periodically provide. 
These updates provide new or updated audios, charts, links and other data. Instructions are provided with 
the updates. 
 
The note at bottom is a text reminder to set your “browser” window setting to display all files types when 
locating the plugins on your system. This is not actually a menu command. 



Printing 

 
There are three “panes” allotted for each chart.  
 
This means that three pages can be displayed per “song.” 
 
Most songs are just one page. (See Chart view section of the manual) 

 
Use the appropriate “Pane” selection to print the actual page(s) you are wanting. 
 

 
 
Sometimes there are more than 3 pages for a particular song 
.  
These are indicated on the songlist with “(continued)” in the song title. 
 
There is no “batch print” function in the program.  
 
Each page of each chart must be selected separately for printing. 
 
Printout size is a function of your printer settings / driver, not the RealBook Software. 
 
You may need to shrink the size of the printed page in order to have everything make it onto the page. 
 
You’ll need to make this adjustment in the print settings / page setup window for your specific printer. 
 

Navigation 

 

 
 
The File Menu also contains navigation commands that will allow you to move up and down on a page or 
move forward or backwards by a single “record”. 
 



Zoom 
 
You can enlarge and reduce the size of the display on the screen. 
 

 
 
The key shortcuts are especially suited for this. 
 

 
 
You can also change the display by clicking the zoom buttons in the lower left hand corner of the screen. 
 
Clicking on the Size indicator at far left will toggle between two zoom levels. 
 
You can also type in the zoom level.  
 
Zoom % options - 25, 50, 75,100,150, 200, 300, 400. 
 

   
 
Next to the Zoom controls are indicators telling you if you are in Browse or Find Mode. 
 
Browse mode is where you will be 99.9% of the time.  
The “Find” mode appears when you are doing a search using the commands available from the Find Menu. 
 
The Laptop View screen is automatically enlarged to 150% in order to fill and center the screen for the best 
viewing. See also “Laptop View” in the manual. 
 
150% may be too larger for your screen.  
 
You can change the Default zoom level for the Laptop View on the Setup page. 
 
Scroll down to the bottom half of the page and you’ll see this. 
 

 
 
Click on the number displayed and you’ll have three zoom levels available in a drop down menu. 
75%,100%,150% 
 
Choose the zoom level that best suits your screen size. 
 
Test this by using the Laptop View menu command in the Go To Menu. 
 
 



The Go To Menu 
 
This menu command allows you to navigate through the main pages of the program. 
 

 
 

1.The “Songlist” command  
This allows you to view and scroll through a list of all the songs contained in the collection. 
 

 
 
This will be your main “control panel.” 
 
It contains specific song information that you can use to sort and find by a variety of criteria. 
 Song Title,  

Composer,  
Musical Style,  
Key Signature,  
Transposition (C, Bb, Eb, Bass Clef) 

 Tempo,  
Recording Artist (Primary and Alternate) 

  
There are also numerous buttons located on the page that will help you to operate the program without 
having to use the Drop Down menus at the top of the screen. 

Sort (up or down),  
Mark Song,  
Chart View,  
Create Links for User Audio,  
Play Audio examples,  
Show All Songs, 
Zoom (enlarge or reduce) 
 
 
 



Here are the features you can activate from this Songlist View using buttons. 
 
a. Sort the list by any of the column categories 
 

 
 
Sort up or down alphabetically (or numbers for Tempo) by clicking on the sort arrows. 
 

 Each column header contains up and down buttons to use for sorting. 
   Mark, (none/marked) 
   Title 
   Composer 
   Style 
   Key 
   Transposition (C, Bb, Eb, Bass Clef) 
   Tempo 
   Primary Recording Audio Artist 
   Alternate Recording Audio Artist 
 
b. Tag (mark) specific songs 
To mark a song or multiple songs, simply click the box located at the far left of the screen next to the 
selected song. This will place a black circle into the box. 

 
This is useful for creating a list of “favorites.” 
Use this to reduce the number of songs that are displayed. (See Find Markers Menu) 
Use Sort Button to sort marked songs. (See also- Find Markers Menu) 
 

c. Chart View Button 
 

 
 
Clicking this button will take you to the page containing the chart(s). 
 
d. User Audio Linking Buttons 
 

 
 
These buttons, located just to the left of the Chart button, will allow you to link to other files on your system. 
Even though the feature indicates linking to audio, you can use this to link to any file type. You might use 
this to link to MIDI files, Band In A Box Files, Text files (maybe your analysis notes), Spread sheets, 
anything you think is important. 
 
Clicking on the button will open up a browser. Use this to navigate to whatever file you are wanting to link to. 
 
To play or launch the linked file, you’ll have to use the Audio menu commands. 
 
If the linked file is moved or deleted, then the link is no longer active and would have to be re-linked. 
 
(Also See the Audio Menu section as well as the Setup Page section) 
 



2. Chart View 
 
The next item on the Go To menu is the Chart command. This takes you to the Chart view. 
 
There are 3 “panes” for each page in the chart view. This will allow you to display up to 3 pages per song. 
 
Most songs are only one page and will appear this way. 

 
 
Here is a song with two pages. 

 
 
And finally, a three page song. 

 



The Chart View also has buttons that duplicate the functions found on the songlist page. 
 
You can use your computer’s scroll bar to move up or down on the page, but there are also up and down 
arrows that do the same thing. (Usually the cursor is closer to the buttons than the edge of the screen.) 

The Left Right Arrows will move you to the next or previous song. 
 
 
 
 
 
 
Down the left side of each “pane” are links to the website.  
 
Click on one of these links and a web browser opens to the site. 
 
 
 
 
 
 

 

3. Laptop View Menu Command 
A very cool feature introduced in version 4.01. 
This allows you to turn your laptop sideways to view the charts to be displayed at about the same size as an 
actual page (depending on your screen size of course). 
 
This also makes it far easier to place your laptop on a music stand or on your piano. 
 
That also means gigging with the RealBook Software programs just got easier. 
 
You aren’t limited to using this on a laptop. You can also do this with your desktop monitor as well if you care 
to a monitor on its side or even using a dual monitor setup. 
 

   
 
There are two viewing options for using your laptop. You can choose either Left or Right depending on 
where the various connections are for your particular model.  
 

To use the buttons on the page you’ll need to turn your mouse or trackball 90° (clockwise or counter 

clockwise, depending on your left or right Laptop View choice), however the indicated keystroke shortcuts 
are recommended for moving between pages and/or songs. 
 
 



Laptop View 
 

 
 
 
 
 
 
 
Song related information is still 
displayed. 
Title, Composer, Style, Key, 
Transposition, Tempo, Primary and 
Alternate Recording Artist. 
 
 
Navigation 
The green arrow keys at the top Left 
hand corner (with laptop on its side) 
will move to the next or previous 
songs. 
 
 
The Left and Right arrows (with laptop 
on its side) will move you between the 
3 panes for songs spanning multiple 
pages. 
 
 
 
 

 
 
 
 
There is a “next page” thumbnail so that you can tell at a glance if there is another page. 
     A small image of a chart appears if there is a next page.  

Otherwise the yellow background will show through. 
 
 

 
 

 
 
You can set the default Laptop View Zoom Level on the Setup Page to   
obtain the best viewing size for your laptop. (see Setup Page). 

 
Audio 
The Light Blue Buttons with the audio artist name will launch the audio. 
 
There is another option that is available from the “Go To” menu. 
The Setup command will take you to the “Setup Page”. 
 
There is also a dedicated Setup Menu command.  
More on this in up ahead since this is a duplicate menu command. 



“Search Online” Menu and Web Links Page 

 
 
 
A new feature in version 5.0 is the ability to do a 
variety of online research about a song, artist, 
etc and then store your findings within each 
song. 
 
Selecting one of these commands will launch 
Google, Wikipedia or You Tube, create your 
search term for you and take you straight to the 
Search Results page. 
(also see the “Lyrics/Text” page section) 
 
Highlight and copy the link of the page you wish 
to capture. 
 
The Web Links page will then display for you to 
insert and label your findings. 

 
Once you are on the page, simply click on the 
Green “Insert” button. 

 
 
A box will come where you will label the link.  
(This label will show up in the “Links” menu.) 
 

 
 
Your Title and Link will be ready to launch. 
Use the Blue Go Button or the “Links” Menu 
 

 
 

  
To remove a link and label use the red Delete button to the right of the link. 



 
You can also load in two of your favorite “Go To” sites that you like to use for researching.  
(Local filepaths to programs can also be loaded here if you prefer) 
 

 
After entering or changing one of these, it is a good idea to hit the refresh button so that 
they will immediately appear in the “Search Online” menu 
 
Any links you place will appear in the Links menu. 

 
The Top 5 are Factory Links and the Lower 5 are your User links. 
 
On the Songlist page there are 2 link indicators. 
 
#1 - If a factory link is present then the Song Title is Underlined and Bolded. 
As new links are added, you’ll be able to update your program with fresh factory links 
where the research has already been done for you! 
 

 
 
#2 – The number at the end of the Song Title field tells you how many total links there are 
for this song. You can also click this to open the Web Links page. 



Lyrics/Text 

In Version 5 you are now able to find and enter Lyrics or other text notes for the songs. 
 
Selecting the Lyrics command from the Search Online menu will launch Google and take 
you straight to the search results page for the song’s lyrics (if available).  
 
On the Lyrics Page there are two panes.  
The one on the Left is the “User” are where you can paste text copied from the internet or 
other sources. The one on the right is “Factory” and cannot be edited. This will allow us to 
send you content updates without overwriting your own “User” entries. 
 

 
 
Once you have copied the desired text, your computer stores it in temporary memory 
(known as the clipboard).  
 
Click in the left “User” pane and a dialog box will appear asking if you want to Paste or 
Cancel. (This will keep you from accidentally overwriting your data at a future date). 
 

 
 
If you need to edit the text then click on the green “Edit Text” button and you will be able to 
make changes to the text. The Factory pane will disappear and the “File” menu options 
will change allowing you to Format, Copy, Paste and Undo also. 

 
 
If you want the “Factory” lyrics to be displayed in the User pane, then click the green 
“Copy Factory Text to User Area” button. 
This is useful if you haven’t entered any text yet and we have sent you an update. By 
doing this, the text will appear on the Charts/Lyrics page also. Otherwise the only place 
you’ll see the Factory text is in the Right Pane of the Lyrics page.  

 



Use the Chart/Lyrics Menu Command to see the Chart and the Lyrics displayed side by 
side 
 

       
 

If either User or Factory Lyrics or Text is present then there are two places where you can 
visually see an “Lyrics/Text Present” indicator. 
 
#1 – The Songlist Page. There is a small box that will show an image of the Lyrics where 
you normally click to insert a marker, just to the left of the Chart Button. 
  

 
 
#2 – The Web Link Page. An image shows up near the top by the Forward/Back button. 
 

 
 

 
 
If no lyrics are present then the indicator boxes will display an empty white background. 
 
 
 
 
 
 



The Links Menu 

 

 
 

This is a dynamic menu that will only appear if there are links present for a particular song. 
 
This menu will change with each song. 
 
If there are no links for a particular record in the database then this menu is not seen. 
 
There are two kinds of links. 
Factory links which come preloaded in the program or can be imported thru periodic 
updates. These cannot be edited, added to or deleted by the user. 
 
User Links. These are links that you paste and label on the Web Links Page. 
 
Clicking on any of these menu options will open your browser and take you straight to that 
web page. 
 
Every chart has a possible 10 links (5 Factory and 5 User) 
However you can expand the number of links by entering a different set of links for each 
transposition. 
(ie: 10 charts in C, 10 in Bb, etc) That would allow for a potential number of 40 links per 
song. 
 
 
 
 
 
 
 
 
 
 
 



The Audio Menu 

 
There are two types of media files associated with the program. 
 
“Factory” - We have provided the main media files and linked them for you. 
“User” - You can also choose other files to link that can be launched from within the program. 
 

Factory Audios can be launched using buttons on the Songlist page, Chart View, and Laptop 
View (There are indicators on the buttons to show when an audio file is present). 

 
 
 

 

You can also play audios by using the drop down menus or the indicated Keystroke shortcuts. 
 

  
 

If you would like to link additional files you can use the User menu commands. 
There are also buttons for doing this on the Setup Page. (see Setup Menu). 
 
Select the Audio 3 (or 4) User Command. Now select the option to Link To A File. 
 

 
 

Browse to the file you wish to link to, select it and click the “open” button or double click the desired file. 
 

 
Be sure the “Store Only A Reference to the file” box is checked 



 
 
Once you have linked a User File, a “link Present” indicator appears.  
 
The Setup page also displays the file name as well as the indicator. 
Hover the cursor over the “indicator” and “Tooltips” will tell you the file name. 
 

 
 

   
 
Use the Audio 3 (or 4)-User>Play command to launch the linked file.  
Use the Delete command to remove the link to the file. (see also Setup Page Menu). 
 

 Audio Randomizer  
 

 
 
This will randomly select songs from the “found set” of songs in the collection and play the corresponding 
recording. 
When you execute this command it will open your default Media player and play the recording. 
The corresponding chart is displayed in the program. 
 
You can use it as a kind of “pop quiz” to test your recognition and familiarity with jazz repertoire and artists. 
(To use the feature as a pop quiz, then you might want to set your Media Player to full screen mode so that 
the RealBook Software is hidden behind the Media Player so the answer isn’t immediately shown to you.) 
 
You can also use this feature to introduce you to new songs that you might not have selected on your own. 
 
 
There is another “randomize” command available from the find menu. (also see the “Find” menu section) 
This will display the chart, but it won’t activate the audio. 

 
  (The Online Media command is reserved for future use and will only 
  appear when there is actual content that has been imported.                 

Otherwise, you will not see this menu command.) 
 
 

 
 



 
 

Audio Setup 

 
All media files are proprietary, specifically named, and intended for use within the program only. 
 

 
 

Do not edit, alter, rename, or otherwise change any aspect of these files.  

 
Any attempt to do so will not only cause the program to not function properly but also constitutes a breach of 
the license agreement. You don’t want to do that. Bad things happen then. 

 
There are instances where no recording is available for a particular song, in which case you’ll see a data 
entry stating “7

th
 Heaven Music (Never Recorded)” in the Audio Artist column. In those instances we have 

created a representative file using Band In A Box. 

 
When launching audio files within the program, your default media player will activate and play the file. 
 
In Windows Media Player, if you “minimize the window it will shrink to the toolbar at the bottom of the 
screen.  
 
This way you won’t have to switch back and forth between Windows Media Player and the RealBook 
Software windows. You’ll be able to operate the Media Player from the minimized window. 

 
If you want to change the program that plays audio files on your system see the Installation and Activation 
Guide – Troubleshooting page.  
 
This will give you the steps needed to re-assign file type associations. (which program plays which type of 
file) 

 
 
 



 
 
 
The program automatically determines the default locations of the audio files; however, if you changed the 
location of the “Materials” folder then you'll need to change the path to the audio files. 
 
1. Make sure that your Default file path is correct  
 a. Go to the Setup Menu>Setup Command> 
  The default path is indicated there. 
 

 
 
b. If the indicated location doesn't match the actual location where your materials file is located, 
then you'll need to enter the correct file path to the "Materials" folder. Follow the instructions just 
underneath the default folder field. 
 
 
Hitting the reset button will restore the filepath setting to the original installation default location in 
the Hard Drive/Application/Program folder. 

 
The default installation folder, where everything has been placed is indicated in the Installation and 
Activation Guide for the product you are installing.  
 
 You may need to modify this if your Install Location does not exactly match. 
 
Hitting the Blue Button will open the Materials Folder if everything has been entered correctly. 
 
If Bonus files were included with the product, they will be located inside the Materials folder in a folder 
named Bonus Files. 
 
No support is offered for files requiring 3

rd
 party software (Band In A Box, MIDI files, Videos etc.). 

 

 
 
 
 
 
 
 



The Find Menu 

 
One of the cool features of the program is the ability to search and find by various criteria. 
You sure can’t do that with a paper book. 
 
You can search by Song Title, Composer, Style, Transposition, Key, and “Other” to initiate a search for 
miscellaneous items not otherwise covered such as Audio Artist or tempo. 
 

 
 
This will allow you to zero in on specific items such as a song title, or groups of items like song styles. 
You could then find every song that was a blues. Or maybe every Miles Davis composition, etc. 
 
To make things even easier still, you can type in a portion of your search criteria. 
For instance, if you were looking for John Coltrane songs, you could Use the “Find Composer” command 
then type in “Joh Co”. 
After typing in your search criteria hit the enter key (some search types require you to hit it twice). 

 
The program will display every song where John Coltrane was listed as a composer. 
 
The “Find Style” Menu utilizes a drop down menu so you don’t even need to type at all. Simply scroll down 
to your selection. Hit the enter key twice. 

 



 
 
You can use the “Find Other” command to find items such as Audio Artists. Click your cursor in the field 
you wish to search through, type your search term, hit enter twice. 

 
 
Use the “Show All Items” command to return to the original listing of songs. (If the command is Grayed 
Out then every song is already shown). 
 

Find Markers Command 

 
Using the Mark feature to tag certain songs, you can do a search for only the songs you have tagged (and 
exclude all others from being displayed). (See page 11 also for more on marking) 
 

        
 
Here we’ve tagged a few songs.  
    



 
 
Now select the Find Markers Command. 
 

 
 
Only the marked songs are shown. This is handy for making lists of songs to play in a set. 
 
 

 
 
Use the Clear Markers command to remove all markers and return to the original songlist display. 
 



 
 
 
Here is a “Power User” tip. If you click in the marker field, it will automatically insert a filled in circle indicator.  
You will then need to hit the enter key (not return) for the marker to be placed. You can also click elsewhere 
on the screen to set the marker 
If you hit the backspace key while that box is still selected (the cursor will flash) , you can then type in 
another key to display a different symbol. When you sort, it will display the songs in order of the selected 
keystrokes.  
 
This is useful when used with the Find and Sort commands. You could use this to create a “set list” of sorts. 
 
Finally, if you make an error in typing or if no info is found that matches your search you’ll see a popup… 
 

 
 
If you happened to enter a search into the wrong field you can simply drag your previous typing into the 
correct field. 
 

     
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



The Randomizer 
 

 
 
When you launch this command, the program will pick songs at random from the currently displayed 
songlist. 
 
If have selected “Show All” then it select from all of the songs in the collection.  
 
You might also decide to narrow down the list to a more selective category by first using the find command 
before using the Randomizer. 
 
Here are some examples of some ideas to try.  
Only songs in the swing genre.  

Wayne Shorter compositions. 
Only songs that you have previously marked.  

Ballads.  
All Bb transposed songs.  

Only songs in the Key of F 
You get the idea.  

 
This is a great tool for forcing yourself to try songs you might not have otherwise taken the time to run 
through or even listen to.  
 
If you have used the Show All Songs command then it will bring up songs from all transpositions.  
 
That is handy for forcing yourself to play the song in unfamiliar ways. 
 
The Randomizer is not available in Laptop View. You can however use keystroke shortcuts to Randomize 
and then switch quickly into Laptop View. 
 
The last Find Menu commands help you to navigate through the charts sequentially via menu or keystroke 
shortcuts instead of arrow buttons.  
 
You can also jump to the very first song or the very last song in the set of songs. 
Use the keystroke shortcuts to make these selections quickly. 
 



The Sort Menu 

 
The Find command is a very powerful function to be able to only display certain items. 
You can also use the Sort commands to sort the displayed data, even in “found” subsets. 
 
As previously mentioned, you can sort up or down by simply clicking the arrows at the top of each column. 
You can also use the Sort menus or keystroke shortcuts to sort the information. 
 
Most of the “Find” criteria can also be used to sort. 
You can sort by Song Title, Composer, Style, Key, Tempo, Transposition, or Markers. 
To sort by Audio Artist, you should use the arrow buttons at the top of each column. 
 
All sorts can be performed Low to High or High to Low. 
 

 
 
NOTE: If you are working with sort categories that have empty fields, then the low to high sorts will place the 
empty fields at the top. You’ll then have to scroll down past the “empty field” zone in order to get to the fields 
with the sorted data in them. 
 
If you click on the “Menu” column header you’ll get a dialog box that will perform the same function as the 
“sort arrows” on the other columns.  
 
Click on your desired sort direction button.  
 

 
 
 



The Setup Menu 
 

 
The Setup menu command will open the Setup Page. 
 

 
 
Here you’ll be able to perform some functions that are only available from this page. 
 
The first function is the Default Materials Folder setting. 
 
Normally the program will automatically determine this location for you.  
 

 
 
There may be circumstances where you want to move the materials folder to another location in order to 
save space on the drive where the program is installed. 
 
If you move the “Materials” folder then you’ll need to tell the program where to find the files. 
 
You’ll need to enter the EXACT file path to the folder’s new location and end your text string with a slash 
character. 
 
To be safe, enter every character as an exact match, including upper and lower case. Make sure there are 
no stray space characters, etc. 
 
You can test your entry by clicking the blue button to the left of the file path you just entered or use the 
Default Folder menu command (or its keystroke shortcut). 
 
If everything has been entered correctly then the Materials folder will open. 



 
Clicking the reset button will return the Filepath setting to the location where the program is installed. 
 
The next section shows the Song Title, Composer and Audio Artist Information from the Songlist View. 
 

 
 
You can click the Song List or Chart buttons to be taken to those pages. 
 
You can also launch the available “factory” audio with the buttons to the left of the “Artist” fields. 
 
Next is the User Audio settings and indicators. 
 

 
 
Use the Link button to select files. 
Use the Play button to launch them. 
Use the Remove buttons to clear the link. 
 
The Linked file names appear in the white boxes. 
 
The Erase Buttons 

 
Typically you will have no use for these buttons.  
  Their only use might come into play when importing     

plugins or updates and somehow ended up with 
duplicated content.  

 
 

 
WARNING: DO NOT Click on these unless it is critical that you do so. 
 
These commands DO NOT have any UNDO function. 
 
There are three Erase commands. 
 
Erase The Selected Chart – permanently removes the chart whose name is appearing in the title above. 
 
Erase The Found Set – Used for removing groups of songs, either freshly imported (and thus the only ones 
displaying) or those that you have marked and “found” using the Find menu. 
 
Erase All – Permanently clears the entire database. 
 

The last command is a default setting for the Zoom level of the Laptop View. 

 



The “Other Software” Menu 

 
This is a quick way to see what other products are available. 
 

 
 
View Catalog – This takes you to the Fakebooks And More page on the website where you can see the 
newest releases. 
 
Order Now – Click on the product you wish to order and you’ll be taken to the online order pages. 
 

The Help Menu 
Documentation 
 

 
 
Most issues that might arise are covered in these manuals. They are on the DVD as well as in the program’s 
directory after installation.. If you don’t have the Manuals handy then this popup window “Get Guide” button 
will open up a web page where you can download the appropriate manual. 
 
For additional helpful tips and insight see the Tooltips section up ahead. 
 
The Visit Website command is a repeat of the Other Software Menu. 
This will take you straight to the www.RealBookSoftware.com/FakebooksAndMore.php web page where 
the latest product info is to be found. 
 
The About command will display the product name and version along with registration info. 
 
 
 
 
 
 
 



Register, Gift Registration and Activate Commands 
 

 
If you selected “run” instead of registering at first then this command will 
re-launch the activation process without having to restart the program. The 
Register command brings up the page for you to fill out your full name and 
email then launch the webpage to fill out the registration form.  
 
 
 

 
 
 

 
 

 
 
The Activate command will bring you to the page for you to apply the activation code once you receive that 
from us.  
 
Gift registration is used if you are not the original purchaser of the program. This lets us create a record for 
you in our database. 

 
 
 
If you have thoroughly read the Installation And Activation Guide and 
this Operation Manual and are experiencing technical difficulty not 
contained in the documentation then you can use the Support 
command to take you to the online help desk. There you will find a 
“knowledgebase” of topics that other users have encountered as well 
as the ability to open up a trouble ticket. One of our staff will help you 
via the help desk system. 
 

 
 

 
 

 
 

 
The Emergency Quit command is another quit command, duplicating the “native” Quit commands on PC 
and Mac as well as the Exit command on the File Menu. 

 
 
 
 
This can act as a safety switch to shut down the program without causing 
damage to the database (which is a risk with the Force Quit command on 
Macs and Task Bar End Process on the PC). 
 

 
 
 

 
 



Data Entry and Editing 
 

Most of the data in the program is fixed and not available for entry or editing. 
There are a few exceptions. 
 
From the Songlist view you can alter the Tempo or Style fields and either enter fresh data 
or edit existing information. 
 
In the Chart View you can also edit the Key of the song in addition to tempo and style. 
 

 
 
 

     
 
To enter or edit data, simply click in ether the Key or Tempo field and begin typing. 
 
The Style section has a drop down menu with all of the current styles already defined. 

 
 

In the Great Jazz Solos program this is used to indicate 
the instrument the solo was played on and not an 
indication of musical style. 
 
To add new Styles to the list, hit the “Other” command 
at the bottom of the list. A box will pop up allowing you 
to create a new style listing. 
 
After creating the entry, hit OK and it will be available in 
the drop down list to be selected. You can now add this 
to your song’s information. 
 
 
 
 
 
 

 
 
 

 
 

 



ToolTips 
 

If you are not sure about the function of a button or other items in the program, then 
additional information can be obtained by placing the cursor over the area and leaving it 
there for a second or two. 
 
A text box (called a Tooltip) will pop up and display useful information about the item in 
question. 
 
Here are some examples of what you will see. 
 
 

Placing the cursor over the Left/Right Arrows displays this tooltip. 
 

 
 
Here, the list of contributing composers was too long to fit inside the regular data field.  
Placing the cursor over the data field reveals the full entry. 
 

 
 
Placing the cursor over the Play button will indicate the Song Name and The Artist. 
 

 
 
If no audio is loaded (this mostly applies to audios for Slot 2) you’ll see this message. 
 

 
 
Here’s what you’ll see while hovering over the User Link buttons on the Songlist view. 
 

 
 
Once linked, the name of the linked file will show up in the Tooltip. 
 

 
 
 
 



Here’s the User Link on the Setup Page. 
 

 
 
Various Sort Button Tooltips. 
 

       
 
 
Style Data Field Tooltip. 
 

     
 
Markers Tooltip. 
 

 
 
 

Setup Page tooltips: 
 

The Blue Button for opening the Materials Folder. 
 

 
 
“Erase Button” tooltips. 
 

    
 
Default Filepath Data Field. 
 

 
 
The Reset button for the Default filepath. 
 

 



 
 
The Show All Songs button. 
 

 
 
The Chart Button tooltip displays the Transposition and Song Title. 
 

 
 
The Song Title data field. 
 

 
 
 
 
 
 

And Finally…. 
 

We are always coming out with new products to enhance and enrich your experience with 
Jazz. 
 
1. Keep current with the latest developments by visiting the web page at 
http://www.RealBookSoftware.com/FakebooksAndMore.php 
 
2. Spread the word and encourage others  
If you have enjoyed and benefitted from our products then please let others know about 
us so that they might also receive the same benefit and enjoyment. 
 
3. Also, send us your testimonials.  
We love hearing from people who are interested in keeping Jazz alive and growing. 
 
Let us know what products or enhancements you would like to see developed. 
You can do this through the help desk. 

 
 
 
 



APPENDIX A 
 
Keystroke Shortcuts (By Key) 
CTRL 1 Go to Songlist Page 

CTRL 2 Go to Chart Page 

CTRL 3 Go to Lyrics/Text Page 

CTRL 4 Go to Charts & Lyrics Page 

CTRL 5 Go to Web Links Page 

CTRL 6 Go to Setup Page 

CTRL 7 Go to Default Folder 

CTRL 8 Search Google - Song 

CTRL 9 Search Wikipedia - Song 

CTRL A Play Audio 1 

CTRL B Play Audio 2 

CTRL C Copy (only available on certain pages) 

CTRL D Find C Transposition Songs 

CTRL E Find Bass Transposition Songs 

CTRL F Find Song Title 

CTRL G Find Artist/Composer 

CTRL H Help - Support 

CTRL I Import Plugins 

CTRL J Find All 

CTRL K Find Key 

CTRL L Mark All Shown 

CTRL M Find Markers 

CTRL N Clear Markers 

CTRL O Find Other 

CTRL P Print - Pane 1 

CTRL Q Quit 

CTRL R Randomizer - Chart 

CTRL S Find Style 

CTRL T Find Bb Transposition Songs 

CTRL U Find Eb Transposition Songs 

CTRL V Paste (only available on certain pages) 

CTRL W Visit Website 

CTRL X Quit - Emergency 

CTRL Y Search - YouTube 

CTRL Z Undo (only available on certain pages) 



CTRL+ALT 1 Laptop View Left - Page 1 

CTRL+ALT 2 Laptop View Left - Page 2 

CTRL+ALT 3 Laptop View Left - Page 3 

CTRL+ALT 4 Laptop View Right - Page 1 

CTRL+ALT 5 Laptop View Right - Page 2 

CTRL+ALT 6 Laptop View Right - Page 3 

CTRL+ALT 7 Search Favorite Site 1 

CTRL+ALT 8 Search Favorite Site 2 

CTRL+ALT A Sort Title -  Up 

CTRL+ALT B Sort Title -  Down 

CTRL+ALT C Sort Artist/Composer -  Up 

CTRL+ALT D Sort Artist/Composer -  Down 

CTRL+ALT E Sort Style -  Up 

CTRL+ALT F Sort Style -  Down 

CTRL+ALT G Sort Key -  Up 

CTRL+ALT H Sort Key -  Down 

CTRL+ALT I Sort Tempo -  Up 

CTRL+ALT J Sort Tempo -  Down 

CTRL+ALT L Print - Lyrics 

CTRL+ALT M Sort Marker -  Up 

CTRL+ALT N Sort Marker -  Down 

CTRL+ALT P Print - Pane 2 

CTRL+ALT R Randomizer - Chart & Audio 

CTRL+ALT T Sort Transposition -  Up 

CTRL+ALT U Sort Transposition -  Down 

CTRL+SHIFT 1 Play User Audio 1 

CTRL+SHIFT 2 Link User Audio 1 

CTRL+SHIFT 3 Clear User Audio 1 

CTRL+SHIFT 4 Play User Audio 2 

CTRL+SHIFT 5 Link User Audio 2 

CTRL+SHIFT 6 Clear User Audio 2 

CTRL+SHIFT 7 Register 

CTRL+SHIFT 8 Activate 

CTRL+SHIFT 9 Gift Registration 

CTRL+SHIFT A Search Google - Composer #1 

CTRL+SHIFT B Search Google - Composer #2 

CTRL+SHIFT C Search Google - Composer #3 

CTRL+SHIFT D Search Google - Composer #4 

CTRL+SHIFT E Search Google - Composer #5 



CTRL+SHIFT F Search Wikipedia - Composer #1 

CTRL+SHIFT G Search Wikipedia - Composer #2 

CTRL+SHIFT H Search Wikipedia - Composer #3 

CTRL+SHIFT I Search Wikipedia - Composer #4 

CTRL+SHIFT J Search Wikipedia - Composer #5 

CTRL+SHIFT L Search Google - Lyrics 

CTRL+SHIFT M Download Manuals 

CTRL+SHIFT P Print - Pane 3 

CTRL+SHIFT Q Links - Factory 1 

CTRL+SHIFT R Links - Factory 2 

CTRL+SHIFT S Links - Factory 3 

CTRL+SHIFT T Links - Factory 4 

CTRL+SHIFT U Links - Factory 5 

CTRL+SHIFT V Links - User 1 

CTRL+SHIFT W Links - User 2 

CTRL+SHIFT X Links - User 3 

CTRL+SHIFT Y Links - User 4 

CTRL+SHIFT Z Links - User 5 

   CTRL+SHIFT Up Zoom In 

CTRL+SHIFT Down Zoom Out 

CTRL Left Navigate - Previous Song 

CTRL Right Navigate - Next Song 

CTRL Up Navigate - Page Up 

CTRL Down Navigate - Page Down 

CTRL+ALT Up Navigate - First Song 

CTRL+ALT Down Navigate - Last Song 

 
 
 
 
 
 
 
 
 



APPENDIX B 
 

Keystroke Shortcuts (By Command) 
 

CTRL+SHIFT 8 Activate 

CTRL N Clear Markers 

CTRL+SHIFT 3 Clear User Audio 1 

CTRL+SHIFT 6 Clear User Audio 2 

CTRL C Copy (only available on certain pages) 

CTRL+SHIFT M Download Manuals 

CTRL J Find All 

CTRL G Find Artist/Composer 

CTRL E Find Bass Transposition Songs 

CTRL T Find Bb Transposition Songs 

CTRL D Find C Transposition Songs 

CTRL U Find Eb Transposition Songs 

CTRL K Find Key 

CTRL M Find Markers 

CTRL O Find Other 

CTRL F Find Song Title 

CTRL S Find Style 

CTRL+SHIFT 9 Gift Registration 

CTRL 2 Go to Chart Page 

CTRL 4 Go to Charts & Lyrics Page 

CTRL 7 Go to Default Folder 

CTRL 3 Go to Lyrics/Text Page 

CTRL 6 Go to Setup Page 

CTRL 1 Go to Songlist Page 

CTRL 5 Go to Web Links Page 

CTRL H Help - Support 

CTRL I Import Plugins 

CTRL+ALT 1 Laptop View Left - Page 1 

CTRL+ALT 2 Laptop View Left - Page 2 

CTRL+ALT 3 Laptop View Left - Page 3 

CTRL+ALT 4 Laptop View Right - Page 1 

CTRL+ALT 5 Laptop View Right - Page 2 

CTRL+ALT 6 Laptop View Right - Page 3 

CTRL+SHIFT 2 Link User Audio 1 

CTRL+SHIFT 5 Link User Audio 2 



CTRL+SHIFT Q Links - Factory 1 

CTRL+SHIFT R Links - Factory 2 

CTRL+SHIFT S Links - Factory 3 

CTRL+SHIFT T Links - Factory 4 

CTRL+SHIFT U Links - Factory 5 

CTRL+SHIFT V Links - User 1 

CTRL+SHIFT W Links - User 2 

CTRL+SHIFT X Links - User 3 

CTRL+SHIFT Y Links - User 4 

CTRL+SHIFT Z Links - User 5 

CTRL L Mark All Shown 

CTRL+ALT Up Navigate - First Song 

CTRL+ALT Down Navigate - Last Song 

CTRL Right Navigate - Next Song 

CTRL Down Navigate - Page Down 

CTRL Up Navigate - Page Up 

CTRL Left Navigate - Previous Song 

CTRL V Paste (only available on certain pages) 

CTRL A Play Audio 1 

CTRL B Play Audio 2 

CTRL+SHIFT 1 Play User Audio 1 

CTRL+SHIFT 4 Play User Audio 2 

CTRL+ALT L Print - Lyrics 

CTRL P Print - Pane 1 

CTRL+ALT P Print - Pane 2 

CTRL+SHIFT P Print - Pane 3 

CTRL Q Quit 

CTRL X Quit - Emergency 

CTRL R Randomizer - Chart 

CTRL+ALT R Randomizer - Chart & Audio 

CTRL+SHIFT 7 Register 

CTRL Y Search - YouTube 

CTRL+ALT 7 Search Favorite Site 1 

CTRL+ALT 8 Search Favorite Site 2 

CTRL+SHIFT A Search Google - Composer #1 

CTRL+SHIFT B Search Google - Composer #2 

CTRL+SHIFT C Search Google - Composer #3 

CTRL+SHIFT D Search Google - Composer #4 

CTRL+SHIFT E Search Google - Composer #5 



CTRL+SHIFT L Search Google - Lyrics 

CTRL 8 Search Google - Song 

CTRL+SHIFT F Search Wikipedia - Composer #1 

CTRL+SHIFT G Search Wikipedia - Composer #2 

CTRL+SHIFT H Search Wikipedia - Composer #3 

CTRL+SHIFT I Search Wikipedia - Composer #4 

CTRL+SHIFT J Search Wikipedia - Composer #5 

CTRL 9 Search Wikipedia - Song 

CTRL+ALT D Sort Artist/Composer -  Down 

CTRL+ALT C Sort Artist/Composer -  Up 

CTRL+ALT H Sort Key -  Down 

CTRL+ALT G Sort Key -  Up 

CTRL+ALT N Sort Marker -  Down 

CTRL+ALT M Sort Marker -  Up 

CTRL+ALT F Sort Style -  Down 

CTRL+ALT E Sort Style -  Up 

CTRL+ALT J Sort Tempo -  Down 

CTRL+ALT I Sort Tempo -  Up 

CTRL+ALT B Sort Title -  Down 

CTRL+ALT A Sort Title -  Up 

CTRL+ALT U Sort Transposition -  Down 

CTRL+ALT T Sort Transposition -  Up 

CTRL Z Undo (only available on certain pages) 

CTRL W Visit Website 

CTRL+SHIFT Up Zoom In 

CTRL+SHIFT Down Zoom Out 
 

 
 
 
 
 
 
 
 
 



APPENDIX C 
 

Commands Without Keystroke Shortcuts 
 

Here are commands that are in Menus but do not have Keystroke Shortcuts 
 
About 

Update>Audios 

Update>Charts 

Update>Data 

Other Software>View New Releases 

Other Software>RealBook Volume 1 

Other Software>RealBook Volume 2 

Other Software>RealBook Volume 3 

Other Software>Great Jazz Solos 

Other Software>Modern Jazz Guitar Volume 1 

Other Software>Charlie Parker Fakebook 

Other Software>Bill Evans Songs and Solos 
 

Here commands that are activated by buttons: 
 
Sort Audio Artist Up 

Sort Audio Artist Down 

Sort Audio Artist 2 Up 

Sort Audio Artist 2 Down 

Sort Source Up 

Sort Source Down 

Delete User Link 1 

Delete User Link 2 

Delete User Link 3 

Delete User Link 4 



Delete User Link 5 

Refresh Menu Labels 

Erase Selected Chart 

Erase Found Set 

Erase All 

Reset Filepath to Program's Directory 

Edit Lyrics 

Commands that are activated by a drop down menu: 
 

Default Laptop Zoom 

Style (Fill Field) 

Title/Type (Edit Field) 
 

Commands that are activated by a Dialog Window 
 

 

Title/Type (Fill Field) 

 
  

 

  


